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Welcome to TeachUcomp, Inc.’s Mastering Excel

Made Easy for Lawyers CPE Edition v.2.0 tutorial. The

purpose of this class is to show the many aspects of

Microsoft Excel that are used in the legal profession.

This class also requires advanced knowledge of the

Microsoft Excel program. Therefore, it is recommended

that you familiarize yourself with the content of

TeachUcomp, Inc.’s Mastering Excel Made Easy tutorial,

which is included within this product, prior to learning

the CPE (Continuing Professional Education) part of the

tutorial that is included within this manual and which

focuses on aspects of the program used by lawyers.

This class takes the knowledge that has been put

forth in the Mastering Excel Made Easy course and

applies that knowledge specifically to tasks that are

common when using Excel in the legal profession.

Introduction and Overview
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CHAPTER 38-

Using Online Templates

38.1- Downloading Templates from Office.com

38.2- Saving a Template

38.2- Creating New Workbooks from Saved Templates
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Using Online Templates

38.1- Downloading Templates from Office.com:

Microsoft Excel allows you to download templates from Office.com if you are using Microsoft Excel

on an internet-connected computer. There are many templates available for legal professionals that allow

you to manage and record time, record consulting on projects, and many other useful things. In this lesson

we will examine how you can connect to Office.com to search for templates that you can download and

save to your computer for use within your law firm.

First open Microsoft Excel. Then, if using Excel 2013:2010, click the “File” tab within the Ribbon and

then click the “New” command shown at the left side of the backstage view. That will then display the

templates that are available in the area to the right. There are thousands of templates available for your

Microsoft Office products, so you will need to search for the types of templates that you want to use. To do

this, click into the search box and then type a keyword of your choosing into the search box. Then click the

“Start searching” button at the right end of the text box, or press the “Enter” key on your keyboard, in order

to display the results of the template search in the area below the search box.

To download a template, simply click on it once to select it. You will see a description and review of

the template appear. If you decide that you would like to download this template, then click either the

“Create” button in Excel 2013 or the “Download” button in Excel 2010 to download and create a copy of this

template on your computer.

The template will then open within Excel, where you can edit and customize it as you wish by adding

your own content to the structure provided.

38.2- Saving a Template:

You can then save a downloaded template to the templates folder within your computer so you will

not need to download it again in the future. To do this, ensure the template is displayed onscreen and then

click the “File” tab within the Ribbon. Then click the “Save As” command shown at the left side of the

backstage view within the template file. If using Excel 2013, then click the “Computer” choice to the right of

the command list. Then click the “Browse” button that appears in the area to the right.

In all versions of Excel at this point the “Save As” dialog box will appear. You can then select either

the “Excel Template” or “Excel Macro-Enabled Template” choice from the “Save as type” drop-down at the

bottom of the “Save As” dialog box. The difference between the choices depends on whether or not the

template contains macro coding within the file. If you want to save a template that contains macro coding,

you must use the “Excel Macro-Enabled Template” choice.

When you make this selection, Excel should change the folder to which it will save the template to

the default templates folder within your computer. Be sure to save the template into this folder that Excel

selects so that Excel will be able to find and display the template choice in the future when you go to create

a new workbook based on the given template in the future. Then enter the name that you want to give to the

template by typing it into the “File name” text box. Then click the “Save” button within the “Save As” dialog

box to save the template to your computer. You can then close the template file displayed within Excel

In the next lesson within this chapter you will examine how to create a new Excel workbook from the

template that you saved to your computer.
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Using Online Templates

38.3- Creating New Workbooks from Saved Templates:

In the last lesson within this chapter, you learned how to save a template to your computer. In this

lesson, you will learn how to create a new workbook from the template that you saved to your computer.

To create a new workbook from a saved template, select the “File” tab in the Ribbon and then click

the “New” command at the left side of the backstage view.

If using Excel 2013, then click the “PERSONAL” category that is displayed underneath the “Search

box” in the area to the right to display the personal templates that you have saved to your computer within

Excel 2013. These templates will then appear within the templates area below. You can then click on the

name of the template that you want to use as the basis for your new Excel workbook to create a new copy

within Excel.

If using Excel 2010, click the “My templates” icon in the area to the right underneath the “Available

Templates” section in order to open the “New” dialog box. Here you should find your template listed on the

“Personal Templates” tab. Click the template to select it, and then click the “OK” button to create a new

workbook based on the selected template.

You can then add your own data to the new workbook you have created and save it as you normally

would. Note that the changes made to the workbook do not change the original template from which the

workbook was created.
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ACTIONS-

Using Online Templates

DOWNLOADING TEMPLATES FROM OFFICE.COM:

1. If using Excel 2013:2010, click the “File” tab within the Ribbon and then click the “New” command

shown at the left side of the backstage view to display the available templates in the area to the right.

2. To search for templates, click into the search box in the area above the template shown and then type a

keyword of your choosing into the search box.

3. Then click the “Start searching” button at the right end of the text box, or press the “Enter” key on your

keyboard, to display the results of the template search in the area below the search box.

4. To download a template, click it to select it and view a description and review of the template.

5. Then click either the “Create” button in Excel 2013 or the “Download” button in Excel 2010 to download

and create a copy of this template on your computer.

6. The template will then open within Excel, where you can edit and customize it as you wish by adding

your own content to the structure provided.

DOWNLOADING TEMPLATES FROM OFFICE.COM:

1. Ensure the template is displayed onscreen and then click the “File” tab within the Ribbon.

2. Then click the “Save As” command shown at the left side of the backstage view within the template file.

3. If using Excel 2013, click the “Computer” choice to the right of the command list and then click the

“Browse” button that appears in the area to the right.

4. In all versions of Excel at this point the “Save As” dialog box will appear.

5. Select either the “Excel Template” or “Excel Macro-Enabled Template” choice from the “Save as type”

drop-down at the bottom of the “Save As” dialog box.

6. Excel will change the folder to which it will save the template to the default templates folder within your

computer. Be sure to save the template into this folder that Excel selects so that Excel will be able to

find and display the template choice in the future.

7. Enter the name that you want to give to the template by typing it into the “File name” text box.

8. Click the “Save” button within the “Save As” dialog box to save the template to your computer.

9. Close the template file displayed within Excel

CREATING NEW WORKBOOKS FROM SAVED TEMPLATES:

1. Select the “File” tab in the Ribbon and then click the “New” command at the left side of the backstage

view. If using Excel 2010, skip to step #4.

2. In Excel 2013, click the “PERSONAL” category displayed underneath the “Search box” in the area to the

right to display the personal templates that you have saved to your computer. These templates will then

appear within the templates area below.

3. Click on the name of the template that you want to use as the basis for your new Excel workbook to

create a new copy within Excel. Skip to step #7.

4. If using Excel 2010, click the “My templates” icon in the area to the right underneath the “Available

Templates” section in order to open the “New” dialog box.

5. Here you should find your template listed on the “Personal Templates” tab.

6. Click the template to select it and then click the “OK” button to create a new workbook based on the

selected template.

7. At this point, in all versions of Excel, you can then add your own data to the new workbook you have

created and save it as you normally would.Sa
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EXERCISES-

Using Online Templates

Purpose:

1. To be able to save a template to your computer in Excel.

Exercises:

1. Open your Excel application.

2. If using Excel 2013:2010, click the “File” tab within the Ribbon

3. If using Excel 2013, continue with step #4 below. If using Excel 2010, skip to step #8 below.

4. If using Excel 2013, click the “Open” command at the left side of the backstage view.

5. Then click the “Computer” command to the right.

6. Then click the “Browse” button to the right of that to display the “Open” dialog box.

7. Use this dialog box to open the “Law Firm Financial Analysis Worksheet” template that is located in

the “Templates” folder within this product. Now skip to step #11.

8. If using Excel 2010, click the “New” category shown at the left side of the backstage view.

9. If using Excel 2010, click the “New from existing” button within the “Available Templates” category to

open the “New from Existing Workbook” dialog box.

10. Use this dialog box to open the “Law Firm Financial Analysis Worksheet” template that is located in

the “Templates” folder within this product.

11. For all versions of Excel, you will now save the template to the templates folder within your

computer.

12. To do this, first ensure that the template is displayed onscreen within Excel.

13. Click the “File” tab within the Ribbon.

14. Then click the “Save As” command shown at the left side of the backstage view. If using Excel 2010,

skip to step #17. If using Excel 2013, please continue.

15. In Excel 2013, click the “Computer” button to the right.

16. If using Excel 2013, then click the “Browse” button to the right of that.

17. In all versions of Excel, you should now see the “Save As” dialog box appear onscreen.

18. Select the “Excel Template” choice from the “Save as type” drop-down at the bottom of the “Save

As” dialog box.

19. When you make this selection, Excel should change the folder to which it will save the template to

the default templates folder within your computer. Be sure to save the template into this folder so

that Excel will be able to find and display the template choice in the future when you go to create a

new workbook based on the given template in the future.

20. Click the “Save” button within the “Save As” dialog box to save the template to your computer. You

can then close the template file.
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CHAPTER 39-

Legal Templates

39.1- Chapter Overview

39.2- Using the Law Firm Financial Analysis Worksheet

39.3- Using the Law Firm Project Tracker

39.4- Using the Law Firm Project Plan
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Legal Templates

39.1- Chapter Overview:

In this chapter we will review the various law firm templates that are provided within this product.

These templates are provided within this product within the “Templates” folder when browsing the content of

the product that you purchased from TeachUcomp, Inc. You can also open the Excel templates within this

folder by using the handy hyperlinks embedded within the Excel CLE interface and then save them to your

computer.

The remainder of this chapter will cover the usage of these templates. Note that there are many

other types of templates available on Office.com for your use, as well. Advanced users can even create

their own templates to submit to Office.com for other users to access, too. We will now review the templates

within this product and show how they can be used within a law firm.

39.2- Using the Law Firm Financial Analysis Worksheet:

Let’s examine the structure and usage of the “Law Firm Financial Analysis Worksheet.” This

workbook allows you to enter detailed financial information about your law firm, so that you can analyze the

results in order to make better business decisions. You should first note that there are seven color-coded

worksheets shown on the tabs at the bottom of the workbook. Information that is recorded within the

“Actuals,” “Project Parameters,” “Actual Totals,” and “Monthly Billings” worksheets is then used by the

charts shown within the “Billing Timeline,” “Account Billing,” and “Skill Type Billing” worksheets. Note that

some sample data has been included within the data entry worksheets so that you can more easily

understand how the worksheets function together.

Let’s begin by examining the “Project Parameters” worksheet. Within this worksheet you will list

each project by general project type that your firm handles. The sample data is shown in cells A7 through

A12. For each project type listed, you then input what percentage of the total hours of the project is

performed by each general type of skilled worker, which are listed in cells B6 through G6. The percentages

are then entered into the intersecting cells. For each skilled worker listed, you can then enter the billing rate

into the “Blended Rate” cells in cell range B13 through G13. This rate is the average billing rate for

someone with the selected skill set. Once this information has been entered, it will then be referenced by

the other worksheets to determine project billing information. Note that you can also add columns and rows

as needed in order to accommodate your law firm’s business needs.

The next sheet we will examine is the “Actuals” worksheet. Within this worksheet, you enter the

names of the individual projects that your firm handles into the cells shown in column A within the table.

Note that you should also enter the name of each project into the corresponding cells within column A on

the “Actual Totals” and “Monthly Billing” worksheets, as well.

Then, back on the “Actuals” worksheet, you enter the project type for the project into the adjacent

cell in column B. Note that each project type must correspond to one of the project types that you created in

column A of the “Project Parameters” worksheet. You can then input the “Actual Start” and “Actual Finish”

dates for the project. When you input the values into these columns, Excel will then calculate the “Duration”

shown in column F. After that, enter the total number of work hours on the project into the “Actual Work”

column. As you enter the total work for each project, you will see the grand total of work hours displayed at

the bottom of column E.

As you complete the data entry listed, the values shown within all of the other spreadsheets will

calculate themselves. This is the data that is then used for the financial analysis of your projects. If you view

the “Actual Totals” worksheet, you will see the total amounts billed for each general type of skilled worker

for each project. The data shown here is derived from the values entered on the “Actuals” and “ProjectSa
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Legal Templates

39.2- Using the Law Firm Financial Analysis Worksheet (cont.):

Parameters” worksheets. You will also see the “Month of Completion” for each project, as well as grand

totals for all values listed.

You can then click to the “Monthly Billings” worksheet to view the amounts billed for each project

broken down by month of completion.

If you click the “Billing Timeline” worksheet, you can view a line chart that displays the monthly

billings for your firm. This is a chart that represents the data shown within the “Monthly Billings” worksheet.

You can click the “Account Billing” worksheet to view a chart that shows billing amounts by project.

This chart is derived from the data shown within the “Actual Totals” worksheet.

You can click the “Skill Type Billing” worksheet to view a pie chart that displays total billing by

general skill type. This information is taken from the “Actual Totals” worksheet.

Note that you can enter your company’s name in cell A1 within the “Actuals” through “Monthly

Billings” worksheets.

You can also right-click the “Your logo here” picture box at the top of those worksheets and then

select the “Change picture…” command from the pop-up menu that appears in order to open a dialog box

that allows you to select a picture of your company’s logo to add to these sheets, if desired.

39.3- Using the Law Firm Project Tracker:

We will now review using the “Law Firm Project Tracker” workbook. This workbook is very similar in

nature to the “Law Firm Financial Analysis Worksheet.” The layout of information is almost identical,

however the analysis generated from the data tends to emphasize the tracking of the project billing versus

the financial aspect.

Just as when entering data into the “Law Firm Financial Analysis Worksheet,” you begin by entering

data into the “Project Parameters” worksheet. Within this worksheet you will list each project by general

project type and then input what percentage of the total hours of the project is performed by each general

type of skilled worker. For each skilled worker listed, you can then enter the billing rate into the “Blended

Rates” cells in cell range B13 through G13. This rate is the average billing rate for someone with the

selected skill set. Note that you can also add columns and rows as needed in order to accommodate your

law firm’s business needs.

The next sheet we will examine is the “Planning” worksheet. Within this worksheet, you enter the

names of the individual projects that your firm handles into the cells shown in column A within the table.

Note that you should also enter the name of each project into the corresponding cells within column A on

the “Planned Totals” and “Actual Totals” worksheets, as well. The names of the projects entered in the

“Planning” worksheet should automatically populate in column A of the “Tracking” worksheet due to the

linking of the cells with a formula reference- so you should not need to enter that data into the “Tracking”

worksheet.

On the “Planning” worksheet, you enter the project type for the project into the adjacent cell in

column B. Note that each project type must correspond to one of the project types that you created in

column A of the “Project Parameters” worksheet. You can then input the “Estimated Start” and “Estimated

Finish” dates for the project. When you input the values into these columns, Excel will then calculate the

“Duration” shown in column F. After that, enter the estimated total number of work hours on the project into

the “Estimated Work” column. As you enter the total work for each project, you will see the grand total of

estimated work hours displayed at the bottom of column E.

As you complete the estimated work for the clients, you will need to enter the actual project valuesSa
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Legal Templates

39.3- Using the Law Firm Project Tracker (cont.):

into the “Tracking” worksheet. Doing this allows you to compare your estimated values to your actual

values. You do this by filling in the “Actual Start,” “Actual Finish,” and “Actual Work” values for each project

listed. As you complete the data entry, the values shown within all of the other spreadsheets will

automatically calculate themselves. This is the data that is then used for the project tracking.

If you view the “Planned Totals” worksheet, you will see the total amounts planned for billing for

each general type of skilled worker on each project. If you view the “Actual Totals” worksheet, you will see

the total amounts actually billed for each general type of skilled worker on each project.

You can then click to the “Hours Chart” worksheet to view the comparison between the estimated

hours and actual project work hours for each skilled worker type.

You can click the “Billing Chart” worksheet to view a chart that shows the difference between

estimated and actual project billing amounts for each skilled worker type.

Note that you can also enter your company’s name in cell A1 within the “Planning” through “Actual

Totals” worksheets. You can also right-click the “Your logo here” picture box at the top of those worksheets,

and then select the “Change picture…” command from the pop-up menu that appears in order to open a

dialog box that allows you to select a picture of your company’s logo to add to these sheets, if desired.

39.4- Using the Law Firm Project Plan:

We will now review using the “Law Firm Project Plan” workbook. This workbook is almost identical to

the “Law Firm Project Tracker,” however the information entered into the “Law Firm Project Plan” workbook

does not feature any tracking of actuals versus estimates. This workbook is simply used to record the initial

project plan data. So once again, begin by entering data into the “Project Parameters” worksheet. Within

this worksheet you will list each project by general project type and then input what percentage of the total

hours of the project is performed by each general type of skilled worker. For each skilled worker listed, you

can then enter the billing rate into the “Blended Rates” cells in cell range B13 through G13. This rate is the

average billing rate for someone with the selected skill set. Note that you can also add columns and rows as

needed in order to accommodate your law firm’s business needs.

Next, on the “Project Input” worksheet, you enter the names of the individual projects that your firm

handles into the cells shown in column A within the table. Note that you should also enter the name of each

project into the corresponding cells within column A on the “Calculations” worksheet.

On the “Project Input” worksheet, next enter the project type for the project into the adjacent cell in

column B. Note that each project type must correspond to one of the project types that you created in

column A of the “Project Parameters” worksheet. You can then input the “Estimated Start” and “Estimated

Finish” dates for the project. When you input the values into these columns, Excel will then calculate the

“Duration” shown in column F. After that, enter the estimated total number of work hours on the project into

the “Estimated Work” column. As you enter the total work for each project, you will see the grand total of

estimated work hours displayed at the bottom of column E.

As you complete the data entry, the values shown within all of the other spreadsheets will calculate

themselves. If you view the “Calculations” worksheet, you will see the total estimated amounts to be billed

for each general type of skilled worker for each project. The “Hours Chart” shows estimated work hours per

skill type, and the “Billing Chart” shows estimated billing per skill type. As with the other templates, you can

enter your company’s name and logo into the “Project Input” through “Calculations” worksheets, if desired.
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ACTIONS-

Legal Templates
USING THE LAW FIRM FINANCIAL ANALYSIS WORKSHEET:

1. Open the “Law Firm Financial Analysis Worksheet.” Note that there are seven color-coded worksheets

shown on the tabs at the bottom of the workbook: “Actuals,” “Project Parameters,” “Actual Totals,”

“Monthly Billings,” “Billing Timeline,” “Account Billing,” and “Skill Type Billing.”

2. Begin by examining the “Project Parameters” worksheet. Within this worksheet you will list each project

by general project type that your firm handles. The sample data is shown in cells A7 through A12.

3. For each project type listed, input what percentage of the total hours of the project is performed by each

general type of skilled worker, which are listed in cells B6 through G6.

4. The percentages are then entered into the intersecting cells.

5. For each skilled worker listed, you can then enter the billing rate into the “Blended Rate” cells in cell

range B13 through G13.

6. Note that you can also add columns and rows to this worksheet as needed in order to accommodate

your law firm’s business needs.

7. Next examine the “Actuals” worksheet. Here you enter the names of the individual projects that your firm

handles into the cells shown in column A within the table. Note that you should also enter the name of

each project into the corresponding cells within column A on the “Actual Totals” and “Monthly Billing”

worksheets, as well.

8. Back on the “Actuals” worksheet, enter the project type for the project into the adjacent cell in column B.

Note that each project type must correspond to one of the project types that you created in column A of

the “Project Parameters” worksheet.

9. You can then input the “Actual Start” and “Actual Finish” dates for the project. When you input the

values into these columns, Excel will then calculate the “Duration” shown in column F.

10. Enter the total number of work hours on the project into the “Actual Work” column. As you enter the total

work for each project, you will see the grand total of work hours displayed at the bottom of column E.

11. As you complete the data entry, the values shown within all of the other spreadsheets will calculate

themselves. This is the data that is then used for the financial analysis of your projects.

12. If you view the “Actual Totals” worksheet, you will see the total amounts billed for each general type of

skilled worker for each project. The data shown here is derived from the values entered on the “Actuals”

and “Project Parameters” worksheets. You will also see the “Month of Completion” for each project, as

well as grand totals for all values listed.

13. You can then click to the “Monthly Billings” worksheet to view the amounts billed for each project broken

down by month of completion.

14. If you click the “Billing Timeline” worksheet, you can view a line chart that displays the monthly billings

for your firm. This is a chart that represents the data shown within the “Monthly Billings” worksheet.

15. You can click the “Account Billing” worksheet to view a chart that shows billing amounts by project. This

chart is derived from the data shown within the “Actual Totals” worksheet.

16. You can click the “Skill Type Billing” worksheet to view a pie chart that displays total billing by general

skill type. This information is taken from the “Actual Totals” worksheet.

17. Note that you can also enter your company’s name in cell A1 within the “Actuals” through “Monthly

Billings” worksheets.

18. You can also right-click the “Your logo here” picture box at the top of those worksheets, and then select

the “Change picture…” command from the pop-up menu that appears in order to open a dialog box that

allows you to select a picture of your company’s logo to add to these sheets, if desired.
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ACTIONS-

Legal Templates
USING THE LAW FIRM PROJECT TRACKER:

1. Open the “Law Firm Project Tracker” workbook. This workbook is very similar in nature to the “Law Firm

Financial Analysis Worksheet.” The layout of information is almost identical, however the analysis

generated from the data tends to emphasize the tracking of the project billing.

2. Begin by entering data into the “Project Parameters” worksheet. Here you will list each project by

general project type and then input what percentage of the total hours of the project is performed by

each general type of skilled worker.

3. For each skilled worker listed, you can then enter the billing rate into the “Blended Rates” cells in cell

range B13 through G13.

4. Next, examine the “Planning” worksheet. Within this worksheet, you enter the names of the individual

projects that your firm handles into the cells shown in column A within the table.

5. Note that you should also enter the name of each project into the corresponding cells within column A

on the “Planned Totals” and “Actual Totals” worksheets, as well. The names of the projects entered in

the “Planning” worksheet should automatically populate in column A of the “Tracking” worksheet due to

the linking of the cells with a formula reference- so you should not need to enter that data into the

“Tracking” worksheet.

6. On the “Planning” worksheet, enter the project type for the project into the adjacent cell in column B.

Note that each project type must correspond to one of the project types that you created in column A of

the “Project Parameters” worksheet.

7. You can then input the “Estimated Start” and “Estimated Finish” dates for the project. When you input

the values into these columns, Excel will then calculate the “Duration” shown in column F.

8. Enter the estimated total number of work hours on the project into the “Estimated Work” column. As you

enter the total work for each project, you will see the grand total of estimated work hours displayed at

the bottom of column E.

9. As you complete the estimated work for the clients, you will need to enter the actual project values into

the “Tracking” worksheet. Doing this allows you to compare your estimated values to your actual values.

You do this by filling in the “Actual Start,” “Actual Finish,” and “Actual Work” values for each project

listed. As you complete the data entry, the values shown within all of the other spreadsheets will

automatically calculate themselves. This is the data that is then used for the project tracking.

10. If you view the “Planned Totals” worksheet, you will see the total amounts planned for billing for each

general type of skilled worker on each project.

11. If you view the “Actual Totals” worksheet, you will see the total amounts actually billed for each general

type of skilled worker on each project.

12. You can then click to the “Hours Chart” worksheet to view the comparison between the estimated hours

and actual project work hours for each skilled worker type.

13. You can click the “Billing Chart” worksheet to view a chart that shows the difference between estimated

and actual project billing amounts for each skilled worker type.

14. Note that you can also enter your company’s name in cell A1 within the “Planning” through “Actual

Totals” worksheets.

15. You can also right-click the “Your logo here” picture box at the top of those worksheets, and then select

the “Change picture…” command from the pop-up menu that appears in order to open a dialog box that

allows you to select a picture of your company’s logo to add to these sheets, if desired.
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ACTIONS-

Legal Templates
USING THE LAW FIRM PROJECT PLAN:

1. Open the “Law Firm Project Plan” workbook. This workbook is almost identical to the “Law Firm Project

Tracker,” however the information entered into the “Law Firm Project Plan” workbook does not feature

any tracking of actuals versus estimates. This workbook is used to record the initial project plan data.

2. Begin by entering data into the “Project Parameters” worksheet. Within this worksheet you will list each

project by general project type and then input what percentage of the total hours of the project is

performed by each general type of skilled worker.

3. For each skilled worker listed, you can then enter the billing rate into the “Blended Rates” cells in cell

range B13 through G13.

4. Next, on the “Project Input” worksheet, enter the names of the individual projects that your firm handles

into the cells shown in column A within the table. Note that you should also enter the name of each

project into the corresponding cells within column A on the “Calculations” worksheet.

5. On the “Project Input” worksheet, enter the project type for the project into the adjacent cell in column B.

Note that each project type must correspond to one of the project types that you created in column A of

the “Project Parameters” worksheet.

6. You can then input the “Estimated Start” and “Estimated Finish” dates for the project. When you input

the values into these columns, Excel will then calculate the “Duration” shown in column F.

7. After that, enter the estimated total number of work hours on the project into the “Estimated Work”

column. As you enter the total work for each project, you will see the grand total of estimated work hours

displayed at the bottom of column E.

8. As you complete the data entry, the values shown within all of the other spreadsheets will calculate

themselves. If you view the “Calculations” worksheet, you will see the total estimated amounts to be

billed for each general type of skilled worker for each project.

9. The “Hours Chart” shows estimated work hours per skill type, and the “Billing Chart” shows estimated

billing per skill type.

10. Note that you can also enter your company’s name in cell A1 within the “Project Input” through

“Calculations” worksheets, if desired.

11. You can also right-click the “Your logo here” picture box at the top of those worksheets, and then select

the “Change picture…” command from the pop-up menu that appears in order to open a dialog box that

allows you to select a picture of your company’s logo to add to these sheets, if desired.
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EXERCISES-

Legal Templates
Purpose:

1. To be able to enter information into a template.

Exercises:

1. Open your Excel application.

2. Click the “File” tab in the Ribbon, and then click the “New” command. If using Excel 2013, please

continue to the next step. If using Excel 2010, skip to step #5.

3. If using Excel 2013, click the “Personal” category to the right to display the templates saved to your

computer.

4. Click the “Law firm financial analysis worksheet” template choice to create a new copy from the

selected template. Note that this is the template that was saved to the computer in the Exercise at

the end of Chapter 1. If using Excel 2013, now skip to step #8.

5. If using Excel 2010, click the “My Templates” button within the “Available templates” section.

6. If using Excel 2010, then in the “New” dialog box that appears select the “Law firm financial analysis

worksheet” template from the listing shown. Note that this is the template that was saved to the

computer in the Exercise at the end of Chapter 1.

7. If using Excel 2010, click the “OK” button to create a new workbook from the selected template.

8. In all versions of Excel, click the “Actuals” worksheet tab.

9. Hold down the “Shift” key on your keyboard and then click the “Monthly Billings” worksheet tab. All

worksheets between the “Actuals” and “Monthly Billings” should be selected.

10. Click into cell A1.

11. Type “My Law Firm” as the company name into cell A1 and exit the cell to save your data entry.

12. Click the “Billing Timeline” worksheet tab to break the grouping you created.

13. Click the “Actuals” worksheet tab.

14. Click the gray row selector for row 29.

15. On the “Home” tab in the Ribbon, click the “Insert” button in the “Cells” button group, and then select

“Insert Cells” to insert a new row.

16. Use the “AutoFill” handle in the corner of cell B28 to extend the list down to cell B29.

17. Click into cell A29 and type “Newco, Inc.”

18. Click into cell B29 and type “Business Incorporation.”

19. Type “11/11/2004” into cell C29.

20. Type “12/1/2004” into cell D29.

21. Type “100” into cell E29.

22. Select the “Actual Totals” worksheet.

23. Click the gray row selector for row 29.

24. On the “Home” tab in the Ribbon, click the “Insert” button in the “Cells” button group, and then select

“Insert Cells” to insert a new row.

25. Click into cell A29 and type “Newco, Inc.”

26. Select the cell range B28 through I28.

27. Click the “Copy” button in the “Clipboard” button group on the “Home” tab in the Ribbon.

28. Select cell B29.

29. Click the “Paste” button in the “Clipboard” button group on the “Home” tab in the Ribbon.

30. Press the “Esc” key on your keyboard to get rid of the blinking selection marquee.

31. Select the “Monthly Billings” worksheet.Sa
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EXERCISES-

Legal Templates
Exercises (cont.):

32. Click the gray row selector for row 29.

33. On the “Home” tab in the Ribbon, click the “Insert” button in the “Cells” button group, and then select

“Insert Cells” to insert a new row.

34. Click into cell A29 and type “Newco, Inc.”

35. Select the cell range B28 through O28.

36. Click the “Copy” button in the “Clipboard” button group on the “Home” tab in the Ribbon.

37. Select cell B29.

38. Click the “Paste” button in the “Clipboard” button group on the “Home” tab in the Ribbon.

39. Press the “Esc” key on your keyboard to get rid of the blinking selection marquee.

40. Click the “Account Billing” worksheet.

41. Select the “Design” tab of the “Chart Tools” contextual tab that appears within the Ribbon, and then

click the “Select Data” button in the “Data” button group.

42. Click into the “Chart data range” text box within the “Select Data Source” dialog box and change the

two references to 28 into 29. This will then add the new data to the chart range. The end result of

what should appear in this text box is: ='Actual Totals'!$A$7:$A$29,'Actual Totals'!$I$7:$I$29.

43. Click the “OK” button to set the new chart data range. Notice that the “Newco, Inc.” project now

appears within this chart.

44. Click the “File” tab within the Ribbon and then click the “Save As” command.

45. Save the document to your default “Documents” folder on your computer with the file name “My Law

Firm Financial Analysis.”

46. Click the “Save” button within the “Save As” dialog box, if needed.

47. Close the Excel application.
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CHAPTER 40-

Legal Business Functions

40.1- The Pv Function

40.2- The Fv Function

40.3- The IRR and XIRR Functions
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Legal Business Functions

40.1- The Pv Function:

Most of the functions that a lawyer needs to know assist them in business and financial

computations. These functions can be used both for the law firm as well as its clients- for example figuring

out the future value of a purchased asset is often useful for both parties. In this chapter we will discuss

some of the most commonly used functions that legal professionals should know how to use. While it is

often said that it always important to have a calculator available as a lawyer, Excel also doubles as a

calculator. A calculator that contains a vast array of business functions that can assist both you and your

clients in many ways.

The first function that we will be learning about is the Pv function. The Pv function assists you in

determining the present value of an investment. The present value is the total amount that a series of future

payments is worth right now. For example, when you borrow money, the present value to the lender is the

original loan amount.

While this may not seem like a function that you would use very often, the Pv function contains many

arguments that allow it to be very useful. Note that arguments are simply the pieces of information that are

needed by a function in order to return a result. Let’s examine the syntax of the Pv function and the

arguments that the function uses.

Formula Syntax:

PV(rate, nper, pmt, [fv], [type])

Arguments:

Rate Required

The interest rate per period. For example, if you receive an interest 

rate of 6% per year on a loan, the monthly rate on the payments 

would be 6%/12, or .5%. You could enter 6%/12, .5%, or 0.005 into 

the formula as the Rate argument.

Nper Required

The total number of payment periods. For example, if you make 

monthly payments on a 6 year loan, the loan has 72 payments. You 

would enter 72 as the Nper argument within the formula.

Pmt Required

The unchanging payment made each period. Typically includes 

payment and interest, but no fees. On a $10,000 loan at a 6% annual 

interest rate for 6 years the payment amount would be $165.73. You 

would enter -165.73 into the formula as the pmt argument.

Fv Optional

The future value or cash balance that you want to attain after the last 

payment is made. If omitted, this argument is assumed to be zero. 

For example, if you wanted to save $50,000 over 20 years then 

$50,000 would be entered as the fv argument in the formula. Note 

that if the fv argument is omitted, then the pmt argument is required.

Type Optional
Enter 0, or omit, if payments are due at the end of the period. Enter 1 

if the payments are due at the beginning of each period.
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Legal Business Functions

40.2- The Fv Function:

The next function that we will be learning about is the Fv function. The Fv function assists you in

determining the future value of an investment based on periodic but constant payments with a constant

interest rate. The future value is the total amount that a series of payments will be worth at a specified future

time. For example, if you saved $100 a month over one year into an account that earns 6% interest, the

future value in a year would be $1233.56.

This function can be useful in determining the future value within an interest-bearing account, such

as an IOLTA account for example. Let’s examine the syntax of the Fv function and the arguments that the

function uses.

Formula Syntax:

FV(rate, nper, pmt, [pv], [type])

Arguments:

Rate Required

The interest rate per period. For example the monthly interest rate on

an account that pays 6% interest per year would be 6%/12, or .5%. 

You could enter 6%/12, .5%, or 0.005 into the formula as the Rate 

argument.

Nper Required
The total number of periods. For example, if you placed $100 into an 

account each month for a year the nper argument would be 12.

Pmt Required

The unchanging payment made each period. Typically includes 

payment and interest, but no fees. For example, if you placed $100 

into an account each month for a year the pmt argument would be 

-100.

Pv Optional

The present value or lump-sum amount that a series of future 

payments is worth right now. If omitted, this argument is assumed to 

be zero. Note that if the pv argument is omitted, then the pmt

argument is required.

Type Optional
Enter 0, or omit, if payments are made at the end of the period. Enter 

1 if the payments are made at the beginning of each period.
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Legal Business Functions

40.3- The IRR and XIRR Functions:

As a lawyer, you will probably handle many different types of projects or matters. It can be useful to

know which types of projects are the most profitable for you to pursue. One way of determining this is by

using the IRR function within Excel to determine the internal rate of return on projects. The internal rate of

return is simply a number that shows you the profitability of a project. The larger the IRR number, the more

profitable the project. IRR finds this number by examining the flow of cash that you input into cells within an

Excel worksheet. You can input a series of cash flows (money going in and out of your firm) for a particular

type of project, and then use the IRR function on those cash flows to determine the rate of return for the

project. You will then be able to see which types of cases and projects tend to produce a higher IRR for

your firm so that you can try to focus on pursuing those types of projects in the future.

Note that the difference between the IRR function and the XIRR function has to do with the time

periods used to denote the cash flows that you input into the cells. If you record cash flows at a regular time

interval, for example the cash spent and received each month, then you can use the IRR function to

determine your rate of return. If, however, you input cash flows that occur at irregular intervals, then you will

need to also label the amounts entered with the associated date and then use the XIRR function to

determine the rate of return for the amounts entered. The number received as a result of either function is

always shown as the rate at the end of the cash flow periods. Also note that expenses incurred (cash going

out) should be entered as a negative number while cash received should be entered as a positive number.

Formula Syntax:

IRR(values, [guess]) XIRR(values, dates, [guess])

Arguments:

Values Required

The series of cash flow amounts. Payments or costs must be 

entered as negative numbers. The series must contain at least one 

positive and one negative number. If using the IRR function, the 

series of values is interpreted in the order they are entered.

Dates
Required (for 

XIRR)

A schedule of dates that corresponds to the order of the cash flow 

entries. Dates should be entered using the DATE function, as errors 

can occur when they are entered as text. For example, the 25th of 

May, 2012 should be entered as =DATE(2012,5,25). All dates must 

correspond to a cash flow entry. No date can be earlier than the 

initially entered date. All dates must be valid. If there is an error with 

the date entry, the XIRR function will return the #NUM! error result.

Guess Optional

An optional guess that is close to the rate that you believe the IRR 

function will return. If omitted, Excel assumes the argument to be .1, 

or 10%. Excel uses an iterative technique to calculate IRR. Starting 

with the guess argument, it will attempt to find a result that works 

until it is accurate within .00001 percent. If it cannot find an accurate 

result after 20 tries, it will return the #NUM! error. If you receive an 

error result or the result is obviously incorrect, try again with a 

different guess argument value.Sa
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ACTIONS-

Legal Business Functions
USING THE PV FUNCTION:

1. Select the cell in the worksheet where you want the result of the function to be displayed.

2. Type =PV(rate, nper, pmt, [fv], [type]), where rate, nper, pmt, fv and type are the values, or cell 

references to cells within the worksheet that contain the values, that you wish to use. Note that the first 

three are required arguments and the last two are optional.

3. Exit the cell to see the result of the function.

USING THE FV FUNCTION:

1. Select the cell in the worksheet where you want the result of the function to be displayed.

2. Type =FV(rate, nper, pmt, [pv], [type]), where rate, nper, pmt, pv and type are the values, or cell 

references to cells within the worksheet that contain the values, that you wish to use. Note that the first 

three are required arguments and the last two are optional.

3. Exit the cell to see the result of the function.

USING THE IRR FUNCTION:

1. Select the cell in the worksheet where you want the result of the function to be displayed.

2. Type =IRR(values, [guess]), where values and guess are the values, or cell references to cells within 

the worksheet that contain the values, that you wish to use. Note that the first argument is required and 

the last is optional.

3. Exit the cell to see the result of the function.

USING THE XIRR FUNCTION:

1. Select the cell in the worksheet where you want the result of the function to be displayed.

2. Type =XIRR(values, dates, [guess]), where values, dates and guess are the values, or cell references 

to cells within the worksheet that contain the values, that you wish to use. Note that the first two 

arguments are required and the last is optional.

3. Exit the cell to see the result of the function.
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EXERCISES-

Legal Business Functions
Purpose:

1. To be able to create a calculator worksheet that allows you to quickly calculate the FV function.

Exercises:

1. Open your Excel application.

2. Create a new, blank workbook.

3. Click into cell A1, if needed.

4. Type “Fv Function:” into the cell.

5. Click into cell B1.

6. Type “Rate:” into the cell.

7. Click into cell C1.

8. Type “Nper:” into the cell.

9. Click into cell D1.

10. Type “Pmt:” into the cell.

11. Click into cell E1.

12. Type “Pv (optional):” into the cell.

13. Click into cell F1.

14. Type “Type (optional):” into the cell.

15. Now we will find out what the future value would be in a year if we placed $100 per month into an

account that returns 6% interest per year but contains an initial balance of zero dollars.

16. Click into cell B2.

17. Type “.5%” into the cell.

18. Click into cell C2.

19. Type “12” into the cell.

20. Click into cell D2.

21. Type “-100” into the cell.

22. Click into cell A2.

23. Type “=FV(B2,C2,D2)” into the cell.

24. Click into cell A3 and view the result shown in cell A2. The result should be $1,233.56.

25. Now to be able to quickly see what the future value would be in two years, simply click into cell C2

and enter “24” into the cell.

26. Exit the cell to view the change to the function. In two years the value would be $2,543.20.

27. You can close the workbook when finished and save it if you like.
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41.1- IOLTA Basics

41.2- Using Excel for Simple IOLTA Management

41.3- Using the Simple IOLTA Template

CHAPTER 41-

Simple IOLTA Management
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41.1- IOLTA Basics:

In this chapter, we will learn how to perform simple IOLTA management within an Excel workbook.

An IOLTA, or Interest on Lawyer’s Trust Account, is used to hold client funds separately from the funds of a

law firm or individual lawyer. An IOLTA account is an interest-bearing checking account. The interest

earned from all IOLTA accounts within a state is pooled together to assist low-income individuals to afford

legal aid.

An IOLTA account is used in three main situations. First being when a lawyer receives funds from a

client to perform legal services. Second being when a lawyer receives funds from a settlement that must be

paid to a client. Third being when a lawyer receives funds or is otherwise holding property for clients that

the lawyer has not yet earned or must return at a later date. A lawyer cannot hold their fund and the client’s

funds in the same account, so IOLTA accounts are used to separate these funds and hold smaller amounts

of money from clients for a short span of time.

An important note to make here is that if a lawyer intends to hold a large sum of money for a client,

or intends to hold the funds for an extended period of time, the lawyer should NOT place those funds into an

IOLTA account but should rather place the funds into an account to be held in trust for that particular client.

In this chapter we will learn how to perform basic financial tracking of an IOLTA account within a

single Excel workbook. Note that while we will learn how to perform the tracking of these funds using

checkbook register style worksheets within a workbook, doing this does NOT typically satisfy ALL of the

IOLTA reporting requirements that are needed by the individual states. You will still need to consult your

own state’s Bar Association or counsel to ensure that you are tracking and reporting the IOLTA account

funds in accordance with their guidelines. It is important to note that each state has its own rule of

professional conduct regarding the handling of client trust funds. You should consult your own state’s Bar

Association or counsel to ensure that your setup is in compliance with the rules for your state. Failure to

comply could result in penalties.

Simple IOLTA Management

41.2- Using Excel for Simple IOLTA Management:

If allowed by your state, you can use Excel to track the balance in an IOLTA account as well as

create individual client ledgers that list all IOLTA transactions. This information can then be copied to a new

workbook and modified as needed in order to comply with many state’s IOLTA reporting requirements.

If you are skilled in using Excel, you will no doubt be able to create the needed worksheets within a

workbook that will allow you to track and then report on the IOLTA account for your state. However, we

have also included a simple IOLTA management template that you can use to track IOLTA account funds

within Excel, if you prefer. You can modify this template, as needed, in order to track your IOLTA account

information for your state. In the next lesson, we will examine using the “Simple IOLTA Template” to track

the accounting data required for IOLTA reporting.
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41.3- Using the Simple IOLTA Template:

In this lesson, we will examine using the simple IOLTA template that can be found in the

“Templates” folder within this product. This workbook allows you to record the basic accounting information

needed for IOLTA management. The template initially contains four worksheets: the “Firm Journal” and

three “Client Name Journals.” The basic structure shown within each worksheet is a basic checking register.

Within these worksheets, you will record all IOLTA transactions into the appropriate ledgers as they occur.

Note that every transaction that occurs within the IOLTA account MUST be recorded into the “Firm

Journal” worksheet. For each client’s transaction, the transaction should be recorded into the “Firm Journal”

as well as the “Client Journal” for the selected client. Each client for whom you hold funds in the IOLTA

account should have their own “Client Journal” worksheet.

You can change the names of the individual “Client Name Journal” worksheets by double-clicking on

them in order to highlight their titles. You can then replace the worksheet labels named “Client Name 1,”

Client Name 2,” and so on with the names of your clients. Within each “Client Name Journal,” you can then

type the client’s name into cell A2. Then enter the client’s case file/matter number into cell B2. For each

IOLTA transaction that involves that particular client, you then enter the transaction’s type and/or check

number into the “Transaction Type/Check Number” column. You enter the date of the transaction into the

“Date” column, and then enter a brief description of the transaction into the “Transaction Description”

column. For deposits made into the IOLTA account, enter the amount under the “Debit (Cash In)” column.

For amounts that are spent, enter the amount under the “Credit (Cash Out)” column. The “Account Balance”

column is a formula cell that will simply shown the current account balance for the selected client. Do not

edit the contents of this cell. In the future you can then enter the transactions for that selected client into the

client’s journal worksheet.

After entering each transaction’s details on the “Client Name Journal” for the selected client, you

should also enter the same information into the “Firm Journal” worksheet. This journal will record all

transactions made for all clients within the firm. Start by entering the name of the law firm into cell A2, if

needed. For each transaction, enter the name of the client (as shown in cell A2 of the selected client’s

“Client Journal” worksheet) underneath the “Client Name” column. Note that you can simply copy and paste

this name from the selected client’s “Client Journal” A2 name cell. You then re-enter the transaction data

into the same “Transaction Type/Check Number,” “Date,” Transaction Description,” “Debit (Cash In),” and

“Credit (Cash Out)” fields. You can also copy and paste these cells from the selected client’s “Client

Journal” into the corresponding cells within the “Firm Journal” worksheet. The “Account Balance” cell is a

formula cell that will show the total IOLTA balance for all of the firm’s clients. This is also a formula cell that

you should not edit.

Simple IOLTA Management
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ACTIONS-

Simple IOLTA Management
USING THE SIMPLE IOLTA TEMPLATE:

1. You can change the names of the individual “Client Name Journal” worksheets by double-clicking on 

them in order to highlight their titles. You can then replace the worksheet labels named “Client Name 1,” 

Client Name 2,” and so on with the names of your clients.

2. Within each “Client Name Journal,” you can then type the client’s name into cell A2.

3. Then enter the client’s case file/matter number into cell B2.

4. For each IOLTA transaction that involves that particular client, you then enter the transaction’s type 

and/or check number into the “Transaction Type/Check Number” column.

5. You enter the date of the transaction into the “Date” column, and then enter a brief description of the 

transaction into the “Transaction Description” column.

6. For deposits made into the IOLTA account, enter the amount under the “Debit (Cash In)” column.

7. For amounts that are spent, enter the amount under the “Credit (Cash Out)” column.

8. The “Account Balance” column is a formula cell that will simply shown the current account balance for 

the selected client. Do not edit the contents of this cell.

9. In the future you can then enter the transactions for that selected client into the client’s journal 

worksheet.

10. After entering each transaction’s details on the “Client Name Journal” for the selected client, you should 

also enter the same information into the “Firm Journal” worksheet. This journal will record all 

transactions made for all clients within the firm.

11. Start by entering the name of the law firm into cell A2, if needed.

12. For each transaction, enter the name of the client (as shown in cell A2 of the selected client’s “Client 

Journal” worksheet) underneath the “Client Name” column. Note that you can simply copy and paste 

this name from the selected client’s “Client Journal” A2 name cell.

13. You then re-enter the transaction data into the same “Transaction Type/Check Number,” “Date,” 

Transaction Description,” “Debit (Cash In),” and “Credit (Cash Out)” fields. You can also copy and paste 

these cells from the selected client’s “Client Journal” into the corresponding cells within the “Firm 

Journal” worksheet.

14. The “Account Balance” cell is a formula cell that will show the total IOLTA balance for all of the firm’s 

clients. This is also a formula cell that you should not edit.

Sa
mple

- f
or

 ev
alu

ati
on

 pu
rp

os
es

 on
ly!



29©TeachUcomp, Inc. Mastering Excel Made Easy for Lawyers

EXERCISES-

Simple IOLTA Management
Purpose:

1. To be able to create a new IOLTA workbook from the template and enter basic information.

Exercises:

1. Open your Excel application.

2. If using Excel 2013:2010, click the “File” tab within the Ribbon

3. If using Excel 2013, continue with step #4 below. If using Excel 2010, skip to step #8 below.

4. If using Excel 2013, click the “Open” command at the left side of the backstage view.

5. Then click the “Computer” command to the right.

6. Then click the “Browse” button to the right of that to display the “Open” dialog box.

7. Use this dialog box to open the “Simple IOLTA Template” that is located in the “Templates” folder

within this product. Now skip to step #11.

8. If using Excel 2010, click the “New” category shown at the left side of the backstage view.

9. If using Excel 2010, click the “New from existing” button within the “Available Templates” category to

open the “New from Existing Workbook” dialog box.

10. Use this dialog box to open the “Simple IOLTA Template” that is located in the “Templates” folder

within this product.

11. For all versions of Excel, you will now save the template to the templates folder within your

computer.

12. To do this, first ensure that the template is displayed onscreen within Excel.

13. Click the “File” tab within the Ribbon.

14. Then click the “Save As” command shown at the left side of the backstage view. If using Excel 2010,

skip to step #17. If using Excel 2013, please continue.

15. In Excel 2013, click the “Computer” button to the right.

16. If using Excel 2013, then click the “Browse” button to the right of that.

17. In all versions of Excel, you should now see the “Save As” dialog box appear onscreen.

18. Select the “Excel Template” choice from the “Save as type” drop-down at the bottom of the “Save

As” dialog box.

19. When you make this selection, Excel should change the folder to which it will save the template to

the default templates folder within your computer. Be sure to save the template into this folder so

that Excel will be able to find and display the template choice in the future when you go to create a

new workbook based on the given template in the future.

20. Click the “Save” button within the “Save As” dialog box to save the template to your computer. You

can then close the template file.

21. Now you will need to create a new workbook based on the template. To do this, click the “File” tab in

the Ribbon, and then click the “New” command.

22. If using Excel 2013, please continue to the next step. If using Excel 2010, skip to step #25.

23. If using Excel 2013, click the “Personal” category to the right to display the templates saved to your

computer.

24. Click the “Simple IOLTA Template” choice to create a new copy from the selected template. If using

Excel 2013, now skip to step #28.

25. If using Excel 2010, click the “My Templates” button within the “Available templates” section.

26. If using Excel 2010, then in the “New” dialog box that appears select the “Simple IOLTA Template”

from the listing shown.
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EXERCISES-

Simple IOLTA Management
Exercises (cont.):

27. If using Excel 2010, click the “OK” button to create a new workbook from the selected template.

28. Double-click the “Client Name 1 Journal” worksheet tab so that it appears highlighted.

29. Select the text “Client Name 1” and type “Sandra Smith” so that the name of the worksheet tab

reads “Sandra Smith Journal.”

30. Select cell A2 in the “Sandra Smith Journal” and type “Sandra Smith” into the cell.

31. Select cell B2 and enter the case number “2012-02-1977.”

32. Select cell A5 and enter “Deposit.”

33. Select cell B5 and type “3/13/12” as the date.

34. Select cell C5 and type “Retainer” into the cell.

35. Select cell D5 and type “1000” into the cell.

36. Press the “Enter” key on your keyboard to return to the next row in cell A6.

37. Type “5678” into cell A6.

38. Type “3/13/12” into cell B6.

39. Type “Initial Consultation” into cell C6.

40. Type “500” into cell E6.

41. Press the “Enter” key on your keyboard to exit the cell.

42. Select cells A5 through E6 on the “Sandra Smith Journal” worksheet and then click the “Copy”

button in the Ribbon to copy the cells.

43. Select the “Firm Journal” worksheet tab.

44. Select cell B5 within the “Firm Journal” worksheet and then click the “Paste” button within the

Ribbon.

45. Select cell A5 and type “Sandra Smith.”

46. Copy cell A5 to cell A6.

47. Select cell A2 and then type “Sample Law Firm.”

48. Double-click the “Client Name 2 Journal” worksheet tab so that it appears highlighted.

49. Select the text “Client Name 2” and type “Don Jones” so that the name of the worksheet tab reads

“Don Jones Journal.”

50. Select cell A2 in the “Don Jones Journal” and type “Don Jones” into the cell.

51. Select cell B2 and enter the case number “2012-02-1988.”

52. Select cell A5 and enter “Deposit.”

53. Select cell B5 and type “3/14/12” as the date.

54. Select cell C5 and type “Retainer” into the cell.

55. Select cell D5 and type “1000” into the cell.

56. Press the “Enter” key on your keyboard to exit the cell.

57. Select cells A5 through E5 on the “Don Jones Journal” worksheet and then click the “Copy” button in

the Ribbon to copy the cells.

58. Select the “Firm Journal” worksheet tab.

59. Select cell B7 within the “Firm Journal” worksheet and then click the “Paste” button within the

Ribbon.

60. Select cell A7 and type “Don Jones.”

61. You can then close the workbook. You can save it if you would like to practice more sample data

entry within it at a later point in time.
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